
 

INTRODUCTION TO DREAMWEAVER 
 
Today, students will be using Macromedia Dreamweaver to make changes to their web pages in order to improve 
and refine them. Dreamweaver is a powerful web development tool, great for creating web pages, as well as 
managing the entire web site. Dreamweaver will allow students to create pages graphically as in Composer, but will 
give them much more control over the way they look. Accordingly, it also has a steeper learning curve.  
 
You’ll be focusing on the basics of web page creation in Dreamweaver today, giving students the knowledge to get 
started and explore the program. You should review this page and familiarize yourself with the program prior to the 
lesson. You can follow the instructions here, and also take the Dreamweaver tutorial, which will show you some 
more advanced features. You can access the tutorial by clicking on the Help menu and selecting Using 
Dreamweaver, and then clicking on Dreamweaver Tutorial in the help topics area.  
 
Start off by introducing the program and talking about what they will be doing with it today. Tell students that 
Dreamweaver will give them much more control over their pages and will help to make their pages look more 
professional. Many major commercial web sites are created with Dreamweaver, so they are using a professional-
quality tool. 
 
Tell the students that you will give them a general introduction to the program, and then they will use their 
knowledge to complete their task for the day.  
 
 
DREAMWEAVER WORK AREA 
We’ll start with the way the program is laid out. There are two main functions of Dreamweaver. The first is web 
page creation. The second is web site management (web site management is the arranging, uploading, and updating 
of your web site’s files.) Thus, the work area of Dreamweaver is split into the same two categories:  
 
#1 Site Management – Site Files window. The Site Files window is used to manage your web site (it says Site in the 
upper left hand corner of the window, and is split into two panes.) If the site window is not open, click Window in 
the Menu bar, then Site Files, or simply press the F8 key on your keyboard. 
 
#2 HTML Creation/Editing – The document windows are used to create and edit HTML pages. A new document can 
be created by clicking on File, and New window. This opens a blank HTML page.  
 
Creating a new site: 
The first thing students need to do is create a folder that will hold all of their HTML files and images. (This is site 
management.) Depending on how your computer lab is set up, you may choose to have students save to a folder on 
the hard drive, a networked drive, or a floppy disk. (If students save their work to a folder on a hard drive that isn’t 
accessible over the network, they will need to use the same computer whenever they are working on their web site, 
in order to access their files. Consult with your computer lab expert on the best place to save student work.) 
Complete the following steps to set up their new folders: 
 

1. In Windows, create a new folder (wherever you have decided to save student work). Title the folder with 
your first and last name. Within this folder, create another folder, and call it images (all lower case). It is a 
good idea to have a separate folder for all your images for organizational purposes.  

2. Open Dreamweaver (if you haven’t yet).  
3. Click on the Site menu, and select New Site… A dialog box named Site Definition for Unnamed Site 1 pops 

up. In the Site Name area, type your first and last name, just as you did with the folder you just created in 
Windows.  

4. To the right of where it says Local Root Folder, click on the icon of the folder. In the box that pops up, 
navigate to the folder you just created in Windows. Highlight the folder and click Open, then Select. Make 
sure that you don’t select your images folder, but rather the one with your name. You can check to see if 
you selected the right folder by look at the path that appear in the box to the left of the folder icon.  

5. Don’t worry about any of the other options here, just click OK. A box pops up stating that the initial site 
cache will now be created. Click OK again. 
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6. You should now be looking at the Site window. The left side is blank, and the right side shows your new 
site folder, with the images folder inside it.  

 
You’ve just created the folder that you will do all your web site work in. All HTML pages that you make 
MUST be saved in your site folder, and any images you want to use must be placed in the images folder, and 
then inserted into your web page. If you insert an image that isn’t in your images folder, it won’t appear on your 
page when you later upload your web site! Stress the importance of this to students. Keeping their site folders well 
organized will help immensely when the time comes to upload to the Internet.  
 
 
With this basic site organization out of the way, it’s time to talk about creating web pages in Dreamweaver. Go to 
the File menu and select New File. This will place a new file in your site folder, and will appear immediately on the 
right side of the Site window. (It’s called untitled.html) Change it to read index.html.  
 
NOTE: index.html is the name that should be given to the first page you want to appear on your web site. All web 
browsers automatically look for the index.html file to display first. No other pages should be called index.html. If 
your web site has several pages, index.html is the main page that all others link off of.  
 
Once you’ve changed the name of the file to index.html, double-click it to open it up. You’re now looking at the 
document window. 
 
Document Window 
The Document window shows the current file you are working on.  
It looks like this: 
 

 
 
If the Document Window that students open has tagged text (<html>, <head>), or has a split screen, tell them not to 
worry; they’re about to learn how to change that. 
 
Toolbar 
The document window has a toolbar across the top.  
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Point out the first three buttons on the toolbar.  
 
You can change your current view of the document by clicking on these buttons. Dreamweaver has Design view, 
which is similar to Composer, where you see a visual representation of your page, and Code view, which shows you 
the underlying HTML code. You can also use a combination of these two views that splits your page into half design 
view, half code view. This lets you click on certain parts of your web page and see the corresponding code, or vice 
versa. Have students click on the three buttons to see how it changes the view. (Now is a good time to remind 
students to use Tool Tips to determine what a button does—if they hold their cursor over a button without actually 
clicking it, the function of the button will pop up.)  
 
Just to the right of the page view buttons, there is an area where you can type in the title of the page. What you type 
here is what will appear in the <TITLE> </TITLE> tag. Make sure students understand that this is the page title 
only, and not the name that the file is saved under.  
 
Skip the next button (File Management), and continue to the Preview/Debug in Browser button. Click on this 
button, and you get a drop-down menu with several choices. Students will mostly use the Preview in [browser 
name] command, which will automatically open their page in the selected browser. Students should test their pages 
in both Netscape Navigator and Microsoft Internet Explorer, if possible. If both browsers are not listed here, select 
Edit Browser List and click the + button to add another browser.  
 
These are the main buttons students will be using in this toolbar for now.  
 
Objects Panel 
To the left of the document window is the objects panel. If your objects panel is not open, point your cursor to 
Window (in your menu bar), and click. A list will appear. Click on Objects. A little check will appear next to the 
word, Objects, and the objects panel (seen below) should appear on your screen. 
 

 
 
It has buttons for creating and inserting objects (like images or tables) into your document.  
Point out common buttons the students may use, like Insert Image, Insert Table, or Insert Horizontal 
Rule. Have them use Tool Tips to see what the other buttons do. Some of the buttons near the bottom 
are for inserting more advanced web design elements like Flash or Shockwave. If you have students 
who are familiar with these technologies, have them explore these buttons, as well.  
 
Point out the word Common, with the arrow pointing down next to it. When you click on this, it gives 
you choices for other buttons that can be displayed. Click on the other choices to see the buttons that 
appear. Keep these buttons in mind because they are the easiest way to add content to your page. 
 
We’ll come back to the Layout and View buttons in just a minute.  
 
 
 
 
 
 
 
Properties Panel 
At the bottom of the screen you should see the Properties panel. It looks like this: 
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This is one of the most useful areas of Dreamweaver because it contains many of the options for changing the look 
of the page. Students will probably spend much of their time using the buttons on this panel.  
 
In addition, this panel changes to reflect the options for the particular element you have selected. For example, if 
you are typing text, the panel looks like it does above. You can see that it gives you options to change the Format of 
the text (H1, H2, etc), what font to use, and the size of the font. Less obviously, it allows you to change the color of 
the text (click on the gray box to the right of the Size option. It will open a small window with different color 
swatches you can choose from.). It has buttons for Bold, Italic, right justify, center justify, numbered list, etc. These 
HTML concepts should all be familiar to students, so encourage them to type in some text and experiment with the 
different buttons to change the look of it.  
 
Now, if you had an image on the page and clicked on it, the Properties panel would change to contain options for 
manipulating the image. Have students do this quickly—insert any image, click once on it, and look at the Properties 
panel to see the options available. Clicking on the down arrow on the bottom-right side (underneath the question 
mark and pencil) will expand the panel and give you even more options for the selected page element.  
 
This is a quick explanation of the basic Dreamweaver work area. Students will find most of the options they need to 
change their page in the Objects and Properties panels. Remind them to use their Tool Tips to find the tool they 
need.  
 
When creating a new page in Dreamweaver, you can change some basic aspects of the new page by clicking on the 
Modify menu above the toolbar, and selecting Page Properties. This opens a window containing many basic 
properties of the page that they should be familiar with. They can make the changes they want here, and they will 
affect the entire page. Most of these options can be changed elsewhere as well, but students should be aware of this 
menu and its options.  
 
 
CREATING A PAGE WITH LAYOUT TABLES 
Now, you will show students a great way to create a web page in Dreamweaver that gives them much more control 
over the look of the page: Layout Tables. (Note: It’s best to be working in a new, blank document when creating a 
new layout table.) 
 
The concept is to use tables not just for figures or charts within a web page, but to have the entire page be one giant 
table with lots of cells that hold your content—text, images, colors, etc. This way you can create many cells within a 
table and move your content around from cell to cell to change the look of the page. You could do this with 
Composer, but Dreamweaver gives you a quick and powerful way to do it with Layout Tables.  
 
Have students look at Layout and View in the Objects panel:  
 

 
This is where you can change between Standard view and Layout view. Layout view will allow you to 
easily create layout tables to hold content. Click the Layout view button. A window should pop up 
called Getting Started in Layout View. Have students read this and ask you if they have any questions. 
Make sure you have played with these buttons so that you can answer any questions the students might 
have. Click OK when done reading. You can now click the two buttons under Layout:  

 
 

Click the button on the right, Draw Layout Table. This turns your cursor into crosshairs. Starting at the 
top left of the page, click and drag the cursor to create a rectangle that is about the same size as the 
current document window, then release. You now have a shaded area that is defined as a layout table. 

Now, click on the left button under Layout, which is Draw Layout Cell. You will now create cells that can contain 
your page’s content, so click and drag to make some cells. (You need to click on the Draw Layout Cell button after 
creating each cell, or you can hold down the CTRL key while you drag to make several cells.) 
 
Here’s a sample Layout Table, containing several cells in the places where you might add content (text and images): 
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You can now click inside each cell and add text, an image, a background color, whatever! Notice that when you put 
the cursor on the border of a cell it turns red. Click on it when it’s red and notice the Properties panel. It has 
changed to contain options for the cell. If you click on a grayed-out portion of the layout table, the Properties panel 
changes to contain options for the entire table, such as background color.  
 
Encourage students to think about the content of their web page and create the layout—before adding any actual 
content (such as images or text). Just looking at the page in Layout form will give you an idea of the “look” of the 
page. Tell the students to consider the following design issues:  

• Is the page balanced, or does it have too much content in a certain area?  
• Where is the eye first drawn when looking at the page? Where do you want people to first look when 

they come to the page? 
• Is there enough room for your content? Do you need to break up some of your information into 

multiple pages in order to keep a home page that is simple and engaging? 
 
The layout tables feature makes it much easier to create a well-laid-out web page because it simplifies many of the 
steps that would normally be associated with creating a page this way. Encourage students to use this feature when 
changing and refining their pages. Remind them that it is easiest to create a new, blank page in Dreamweaver, and 
open their old page also. That way they can see what content they have and where they might like to place it on the 
page. It is not recommended to try to change an existing page into a layout tables page—just start from scratch! It 
won’t take long to lay out the basic structure of the page, and will save you many headaches! 
 
 
OTHER THINGS TO KEEP IN MIND 
Page Size 
An issue that students must keep in mind is the size of their page relative to the size and resolution of the computer 
monitor. Monitor resolution is a measurement of the amount of viewable area on screen (some common resolutions 
are 640x480, 800x600, and 1024x768; the bigger the numbers, the more room on screen). Since monitors generally 
range in size from 14 inches to 22 inches, and there are many different screen resolutions possible depending on the 
computer system, a web page creator must design his/her page to look good under any of these conditions. One way 
to do this is to ensure that your page will appear correctly under the “worst” (smallest) possible monitor conditions, 
say a 14-inch monitor with a 640x480 resolution. (NOTE: If the page is too big for the monitor and resolution, it 
usually does not get “cut off.” Rather, the user will have to use the scroll bars on the browser window to see the full 
page. While it may not sound like a big deal, it is generally thought to be annoying and unprofessional.)  
 
Along the bottom right hand corner of the Dreamweaver Document window is a Window Size selector:  
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Click on this to see different monitor resolutions (right side), and the corresponding actual usable screen area (left 
side). They should choose the smallest size possible. Students might be shocked at how small the smallest choice 
actually is. If they would like to try to design a page to fit that size, great! If not, they can choose a bigger size, but 
remind them that some users might not be able to see all of the page without scrolling. The idea is to reach the 
largest possible audience.  
 
HTML Pages 
A web page that is created in Composer does not have to be opened in composer. When it is saved, it is an HTML 
document, meaning that it can be opened in any program that opens HTML documents. This includes any web 
browser, Microsoft Word, Notepad, and most importantly, Dreamweaver. If students want to open their pages 
created in Composer with Dreamweaver, that’s fine. This way, they can copy some of their content from page to 
page. BUT—students need to be making real layout, organization, and hopefully, content changes to their pages, so 
they shouldn’t just be opening the old page and tweaking it slightly. Starting from scratch in Dreamweaver will give 
them better a better understanding of how the program works and ultimately, more control over the page. 
 
If students do copy and paste from their old page to their new, they will notice that many things don’t “come over.” 
For example, copying text from a table that has a blue background color and pasting it into a new table will only 
bring over the text, any links within the text, and the text color, but not the background color of the table cell. If they 
want to keep the same colors, they should use the Dreamweaver Properties panel to adjust background colors of 
tables or table cells. 
 
Adjusting Table and Image Sizes 
If a student inserts an image into a table cell that is bigger than the table cell, the cell will stretch to accommodate 
the size of the image. If that is desired, great. If not, show students how they can resize images. Click on an image 
once. A small border will appear around it, accompanied by a few “handles”—little boxes on the sides and corners 
of the image. The best way to resize an image is to hold down the SHIFT key, then click and hold on the bottom 
right side handle, and drag the image to the desired size. Holding down the SHIFT key forces the image to stay 
proportional when being resized. Holding down the SHIFT key when resizing something should be like second 
nature after a while, because nine times out of ten, you don’t want to distort the image’s proportions.  
 
(NOTE: It’s best to only resize images by a little bit. If you want the image much smaller than the original, you 
should open the image in a program like Photoshop and change the actual image size to what you want it to be. The 
reason for this is file size. It doesn’t make sense to force your user to load a giant image if you have reduced its size 
to that of a postage stamp! This will just take up time and frustrate the person viewing the page. The smaller the file 
size of the images, the better. Have students change the image size in Photoshop, and then make only minor 
adjustments in Dreamweaver.  
 
To adjust the size of a table cell you have already created, move the cursor to the edge of the cell (a blue dotted 
line). When the cursor is on the line, it will turn into a solid, red line. Click on it now. This will produce handles 
around the cell that can be dragged to change the size. Again, holding down the SHIFT key will keep the cell’s 
proportions, which may or may not be desired.  
 
Adding Content 
It is best not to copy and paste images from your old page to your new one. Instead, choose Insert > Image to add 
the image to your new page. After doing this, you may get a dialog box from Dreamweaver saying that the chosen 
image is outside of the root folder of the current site, and would you like to copy it? Choose Yes, and OK. This is 
part of the way Dreamweaver organizes the files that make up your web site. We will discuss this in detail and show 
how to set up a new site in a future lesson. For now, just get Dreamweaver to copy the image so that it will appear. 


